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I. Programmer- Installation and Setup  

I.1. General  

1. What programmers can I use to program Microsemi
®
 devices?  

Ans. Microsemi only tests the programming of Microsemi devices on the FlashPro, Silicon 

Sculptor, and BP Microsystems programmers. Each release of the Silicon Sculptor and 

FlashPro software goes through a rigorous testing procedure to ensure the best programming 

yield possible. This test procedure includes programming devices and functionally testing 

these devices. The Activator programmer has been discontinued, and we no longer provide 

software updates.  

Microsemi does not test programming solutions from any other vendors and cannot 

guarantee programming yield. Microsemi accepts Programming Failure RMAs up to the 

allowed fallout, but reserves the right to reject any RMA requests if the fallout is excessive. 

Microsemi does not perform Failure Analysis on devices programmed by hardware from other 

vendors.  

I.2. Activator  

2. Is there a checklist to follow before programming with Activator?  

Ans. If you are using Microsemi Activator 2 or Activator 2S programmers to program a 

Microsemi FPGA, verify the following before executing any commands from the Windows 

programming software:  

 Activator 2 or (Activator 2S) is powered on and the green LED is on.  

 The appropriate adapter module(s) is plugged into the socket(s) on Activator.  

 A device is inserted in the adapter module, with pin 1 oriented as indicated in 
the diagram printed on the adapter module.  

Note: Insert a device into the adapter module socket AFTER the module is plugged in and 

the Activator is powered up.  

3. How can I verify that the software driver for the Activator (2/2S) is configured properly?  

Ans. Double-click the devices icon located in the Control Panel program group. Look for the 

“Aspi32” driver. Its status should be Started and Automatic.  

4. How do I configure the Adaptec AVA-1505A SCSI Card for Windows 95/98?  

Ans. To configure the Adaptec AVA-1505 SCSI controller card for Windows 95, refer to the 
Activator User's Guide. Once opened, refer to "Installing the 1505A Card" under Windows 
95/98, located in Chapter 2. 

5. How do I configure the Adaptec AVA-1505 SCSI Card for Windows NT 4.0?  

Ans. To configure the Adaptec AVA-1505 SCSI controller card for Windows NT 4.0, refer to 
the Activator User's Guide. 

6. Can I use an existing Adaptec SCSI Controller on a PC?  

Ans. You can only use an Adaptec SCSI controller card with Activator 2 or 2S. You cannot 

use any other manufacturer's SCSI card. You need to find an appropriate SCSI cable to 

match your board's external SCSI connector to the Activator 2 or 2S connector (female DB50 

for Activator 2, DB25 for Activator 2S).  

 

http://www.microsemi.com/soc/documents/Activator_UG.pdf
http://www.microsemi.com/soc/documents/Activator_UG.pdf
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IMPORTANT: Activator 2 or 2S must be the last device in the SCSI chain, as Activator 2 

and 2S contain termination resistors. If SCSI ID number 5 is not available on your SCSI 

bus, set the rotary switch on the back of your Activator 2 or 2S to an available SCSI ID 

and invoke the APSW programming software with an additional parameter, as described 

below. These examples assume that your Microsemi software is installed in the “c:\actel” 

directory, and that you want to use SCSI ID number 4. The following procedure is for 

Windows NT 4.0 or Windows 95.  

1. From the main window, highlight the Start button with the right mouse button.  

2. Select Open All Users (Open for Windows 95) > Programs > Designer Series 

3.1 click Windows Programming.  

3. From the File menu, select Properties > Shortcut tab.  

4. Append "devactivator2: <SCSI ID>" to the command line, as shown below: 

C:\actel\bin\apsw.exe devactivator2:4  

7. How can I determine what IRQ and I/O addresses are used by installed add-in 
cards?  

Ans. Follow the instructions below:  

1. Double-click the Computer icon. The Computer Properties window is displayed.  

2. Click Interrupt Request (IRQ) to view the IRQ already in use.  

3. Click Input/output (I/O) to view the I/O addresses already in use.  

The default interrupt number is IRQ11, but can be set from IRQ9 to IRQ12. The default 

I/O address is 340h-35Fh but can be set to 140h-15Fh.  

For information about changing the I/O address on the 1505A card, refer to the “Jumper 

Block Settings” section in the Adaptec AVA-1505A AT-to-SCSI Host Adapter Installation 

Guide. If all the interrupts between IRQ9 and IRQ12 are being used, you must change 

the IRQ settings on another card to free one of these interrupts for the 1505A card.  

8. The green power light is blinking after I turn on the power in Activator. What is the 
problem?  

Ans. A self-test has failed. Contact Microsemi Technical Support at 1-800-262-1060 or  

soc_tech@microsemi.com for assistance.  

9. What does the error message “SCSI Controller not found” (PC only) mean?  

Ans. The SCSI controller board has not been installed in the PC or there is an SCSI I/O 
address conflict. Also, verify that the device driver(s) were installed correctly. For more 
information, refer to the following knowledge based articles located at: 
www.microsemi.com/soc/kb/article.aspx?id=SL1184  

  

mailto:soc_tech@microsemi.com
http://www.microsemi.com/soc/kb/article.aspx?id=SL1184
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10. What does the error message “Firmware load failed. WARNING: Could Not Connect 
With Activator 2” mean?  

Ans. This message is displayed by Microsemi Windows Programming software when no 

contact with the programmer can be found. If this occurs, check that you have turned on the 

Activator 2/2S programmer and that the SCSI cable is correctly installed. Be especially sure 

that the SCSI cable connection is secure. The locking arms on the SCSI board can easily be 

misaligned. Also, verify that the device driver(s) were installed correctly.  

For more information, see the Activator User's Guide.  

11. What does the message “Error: Activator communication link down. Exiting …” mean?  

Ans. There is a problem with the connection between the Activator and the PC or the 

Activator has lost power. Check the connections (the Activator power light should be 

illuminated), and try re-invoking APSW. For more information, refer to the Activator User’s 

Guide. 

12. Is there any memory in the Microsemi Activator programmer?  

Ans. No. The programming information is downloaded to the programmer during the 

programming of a device.  

I.3. Silicon Sculptor I and II  

13. Where can I find a list of the supported devices for the Silicon Sculptor programmer?  

Ans. To check devices currently supported by Silicon Sculptor, visit: 
 www.microsemi.com/soc/custsup/updates/silisculpt/device_list.html  

14. Is there a checklist to follow before programming with Silicon Sculptor?  

Ans. You need to check several things to start programming with Silicon Sculptor. You can 
find the checklist in the knowledge based document located at: 
www.microsemi.com/soc/documents/SiliSculptQuickRef.pdf 

15. What is the Power-On Self-Test (POST) for Silicon Sculptor?  

Ans. When power is applied to the Silicon Sculptor programmer, it performs a power-on self-

test (POST). This test checks RAM, ROM, CPU, analog circuits, and basic system integrity.  

Note: Do not attempt any programming operations until the POST is complete. If the POST 

fails, the red ERROR LED turns on.  

Failure codes are:  

 Three short flashes: cannot self-calibrate  

 Two short flashes: ROM checksum error  

 One short, one long flash: RAM error  

If you encounter any of these errors, contact Microsemi Technical Support at 1-800-262-1060 

or soc_tech.support@microsemi.com. Do not attempt to program any device if self-test fails.  

16. How many devices can I program successfully on a Silicon Sculptor adapter module?  

Ans. The modules are rated for up to 10,000 insertions. The frequency of running the self-

test is dependent upon usage.  

17. Is there any memory in the Silicon Sculptor programmer?  

Ans. Yes. The memory is used to broadcast the programming information in concurrent 

mode.  

http://www.microsemi.com/soc/documents/Activator_UG.pdf
http://www.microsemi.com/soc/documents/Activator_UG.pdf
http://www.microsemi.com/soc/documents/Activator_UG.pdf
http://www.microsemi.com/soc/custsup/updates/silisculpt/device_list.html
http://www.microsemi.com/soc/documents/SiliSculptQuickRef.pdf
mailto:soc_tech.support@microsemi.com
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II. Adapter Modules 

II.1. Activator  

18. Where can I find a list of adapter module part numbers for Activator?  

Ans. The adapter modules are device, package, and programmer specific. The list of 
modules for Activator is available at:  
www.microsemi.com/soc/products/hardware/program_debug/activator/modules.aspx  

II.2. Silicon Sculptor I and II  

19. Where can I find a list of adapter module part numbers for Silicon Sculptor?  

Ans. The adapter modules are device, package, and programmer specific. The list of 
modules for Silicon Sculptor is available at: 
www.microsemi.com/soc/products/hardware/program_debug/ss/modules.aspx  

20. Can I use the same module for different devices? For example, if I have an SM84P-
Microsemi-1 module, can I use this to program an A1020B PL84 or an A3265DX 
PL84 device?  

Ans. You can program the majority of Microsemi antifuse devices using the same 

package module on the Silicon Sculptor. However, some devices require a new revision 

or a different module for programming. For the appropriate module needed to program 

each Microsemi device, refer to the module list at: 

www.microsemi.com/soc/products/hardware/program_debug/ss/modules.aspx  

21. Can I use Silicon Sculptor Adapter modules to program the Microsemi devices with 
the other BP programmers like BP1400, BP2100 etc?  

Ans. Yes, Microsemi recommends using Silicon Sculptor adapter modules to program 

Microsemi devices with other BP programmers. However, you cannot use other BP 

Adapter modules to program Microsemi devices with Silicon Sculptor. 

http://www.microsemi.com/soc/products/hardware/program_debug/activator/modules.aspx
http://www.microsemi.com/soc/products/hardware/program_debug/ss/modules.aspx
http://www.microsemi.com/soc/products/hardware/program_debug/ss/modules.aspx
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III. Diagnostic/Self-Test 

III.1. Activator  

22. How do I run the Activator 2 test Procedure?  

Ans. You can run the diagnostic test for the Activator 2 and 2S. The procedure is described 

in the knowledge based article located at: 

www.microsemi.com/soc/kb/article.aspx?id=SL1233  

If you use the programmer occasionally, run the self-test before each programming. If you 

use the unit daily, test it once a week.  

III.2. Silicon Sculptor I & II  

23. How do I run a self-test in the DOS version of the Silicon Sculptor software?  

Ans. The Silicon Sculptor programmer can test its own hardware quite extensively. You are 

strongly advised to run a full system self-test on the programmer before performing any other 

operation. The self-test routine can detect problems in the pin drivers, power supply, 

microprocessor, data cable, printer port, and several other circuits.  

To execute the test:  

1. Remove any chips from the programmer sites. Any device left in a programmer site may 

be damaged during testing.  

2. Press Alt-D.  

3. Choose to test a single unit or all units.  

4. Watch the screen for any error messages.  

If you receive an error during the test, contact Microsemi Technical Support at 1-800-262-

1060 or soc_tech@microsemi.com for assistance.  

24. How do I run a self-test in the Windows version of Silicon Sculptor?  

Ans. To run the self-test on your device programmer, click Device, and select Actel 

Diagnostics from the list of available devices (type “diagnostics”). Once selected, the main 

window displays the Actel Diagnostics label in the Device field and a Test File tab appears.  

To test the programmer, click Test. The Test dialog box verifies how many units you wish to 

test. Once you click OK to begin the test, a window is displayed to prompt you to verify that 

there is no chip in the socket. The test starts and runs until it is completed or until you click 

Stop. If you decide to cancel the self-test, click Stop at any time during the procedure. A 

window is displayed acknowledging that the operation was aborted. To re-execute the test, 

simply click Test again. Your programmer should pass the test.  

Verify by checking the green PASS LED on the chassis of the programmer. If your 

programmer does not pass the test, the red FAIL LED is activated and the following error 

message is displayed on-screen:  

 Error 47: Self-test failed. This unit may need service. Please call technical support.   

If this happens, double-check the fidelity of the cable connections and try again. Make a note 
of the exact error message and contact Microsemi Technical Support at 1-800-262-1060 or  
soc_tech@microsemi.com for assistance if you are still having trouble.  

http://www.microsemi.com/soc/kb/article.aspx?id=SL1233
mailto:soc_tech@microsemi.com
mailto:soc_tech@microsemi.com
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25. The self-test failed for the BGA 329 Adapter module for Silicon Sculptor. Why?  

Ans. The lid of the BGA 329 adapter module is made of metal. So when you run the self-

test by keeping the lid closed, it may come in contact with the base of the socket, which is 

also made of metal. It gives you the "self test failed" result for this particular adapter 

module. It is recommended to run the self-test by keeping the lid open for this particular 

adapter module. If it still fails the self-test, contact Microsemi technical support for the 

replacement. You can run self-test for all other modules by closing the lids.  

26. How frequently should I run the self-test?  

Ans. You must ensure that all programming hardware is in good, working condition. This 

requires regular execution of the hardware self-diagnostic test and maintaining valid 

calibration of the programming hardware. Perform the self-diagnostic test before every 

programming session. At a minimum, execute the test every week. 
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IV. Calibration  

IV.1. Activator  

27. How frequently do I need to calibrate Microsemi Activators?  

Ans. Microsemi Activators are calibrated before leaving the factory and should not require 

any further calibration during their lifetime. Microsemi provides a diagnostic utility (Activator 

Diagnostic Test) that you can run to guarantee that Activator is operating within the 

calibration specifications. Microsemi recommends that you run this diagnostic test on a 

schedule that coincides with your normal hardware calibration routine (typically once every 

six months). If you find their Activator “out of specification” after running the diagnostic tool, 

the unit must be calibrated.  

28. How do I perform the calibration of Activator 2/2S?  

Ans. Eagle is responsible for performing the calibration of Activator 2/2S. Please contact 

Eagle if you would like your Activator 2/2S calibrated.  

Their telephone number is 408-748-1545.  

IV.2. Silicon Sculptor I and II  

29. How do I perform the calibration of Silicon Sculptor?  

Ans. Calibration customers should contact BP Microsystems (1-800-225-2102 or 

tech@bpmicro.com) to perform the calibration of Silicon Sculptor. BP charges $75.00 and 

provides an approximate one week turnaround time. Alternatively, a calibration (# 48D) 

socket can be purchased from BP Microsystems for $250, which includes instructions on how 

to check the calibration. During operation, each pin driver is continuously monitored and 

calibrated by a special supervisory circuit. The self-diagnostic test verifies correct operation of 

the pin drivers, power supply, CPU memory, and communications. It is necessary to verify 

the accuracy of the self-test to ensure that it provides accurate results. The programmer uses 

an internal Digital Volt Meter (DVM) to measure the voltage and/or current of 13 internal 

nodes and 48 analog pin drivers, allowing verification. Its accuracy may be verified with a 

bench DVM.  

An option in the self-diagnostic test may be executed to allow testing of the accuracy of the 

internal DVM and time base using a bench DVM and oscilloscope or period counter. 

Microsemi recommends that the following procedure be performed every 12 months. The 

procedure may be performed in the field or at the factory for a charge. If the unit fails the 

accuracy or self-test, return it to the factory for repair and failure analysis.  

Procedures for verifying accuracy of internal DVM  

1. Secure the SM48D in place on the programmer (48 pin DIP socket module: this 

adapter module can only be bought from BP MICROSYSTEM 1-800-225-2102).  

2. Press ALT-D.  

3. Press the T key when prompted.  

4. Connect the black lead of the DVM to Pin 3 of the DIP Socket.  

5. Measure the voltage at pins 1 and 2 of DIP socket and check that they fall within the 

minimum and maximum levels displayed on the screen. 

6. Press any key to continue.  

 

mailto:tech@bpmicro.com


 

12 FAQ’s for Microsemi Antifuse FPGA Programming 

Procedures for verifying AC calibration  

1. Use an oscilloscope or period counter to verify that the positive pulse on pin one is 
between 890 us and 910 us.  

2. The programmer produces a 900 us pulse width on Pin 1 of the DIP socket. This 
completes the trace ability test. The programmer continues with a self-test, and it 
must pass this test. Perform a self-test on each programming socket module that 
you use. 

V. Concurrent Programming  

V.1. Activator  

30. What is the maximum number of Activator programmers that I can daisy chain 
together?  

Ans. Activator programmers cannot be daisy-chained together.  

V.2. Silicon Sculptor I and II  

31. How do I setup Silicon Sculptor for concurrent programming?  

Ans. Silicon Sculptor is a concurrent programmer, meaning that multiple sites can 
simultaneously program the same design. Your PC is used to hold the data that is 
programmed into the devices. Specific programming algorithms and instructions are 
stored on the PC and downloaded to the programmer when you select a chip and load 
the buffer. Thus, the algorithm is actually executed by each programmer’s internal 
microprocessor. This guarantees accurate waveforms and precisely controlled critical 
time delays independent of the PC’s performance. The speed of your PC only affects the 
rate at which the programming algorithm and data is downloaded to the programmer, not 
the programming yield. For more information on how to setup multiple Sculptors to 
facilitate concurrent programming, refer to the Silicon Sculptor Verification of Calibration 
Work Instruction User’s Guide. 

32. What is the max number of Silicon Sculptor programmers that I can daisy chain 
together?  

Ans. The maximum number of 6X programmers that can be daisy-chained together is 

two for 12 programming sites. Microsemi does not support more than four single site 

programmers connected together. 

http://www.microsemi.com/soc/documents/SiliSculptProgCali_UG.pdf
http://www.microsemi.com/soc/documents/SiliSculptProgCali_UG.pdf
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VI. Programming Software  

VI.1. General  

33. What software packages should I use to program Microsemi devices?  

Ans. For Activator: APSW version R1-2000 or newer contains all the latest available 
programming algorithm updates. For Silicon Sculptor: Sculptor for DOS and SculptW for 
Windows. Check the Microsemi website for the latest version: 
www.microsemi.com/soc/custsup/updates/index.html  

VI.2. Activator  

34. Where can I get the APSW software?  

Ans. APSW comes with the Microsemi Designer or Libero
®
 System-on-Chip (SoC) software 

package. Contact your local sales representative to get the latest version of the software.  

35. Does the programming software also work on HP/Solaris workstations?  

Ans. APSW is available for HP and Solaris workstations, but the Silicon Sculptor software is 

only available for DOS or Windows.  

36. How do I verify the functionality of a programmed device with the APSW debugger?  

Ans. The Activator 2/2S can be used to verify functionality of a Microsemi FPGA (not 
available for SX and newer devices) by using special debugger software to stimulate inputs 
and to observe outputs and internal nodes. For complete information on how to invoke the 
debugger software and write verification commands, refer to the Activator User’s Guide. 

37. What is the .avi/.txt file? When and where is it generated?  

Ans. The .avi/.txt file is a generated log file when a Microsemi FPGA is programmed. The file 
contains information about the number of VPP voltage pulses applied to each fuse to 
program the fuse and the programming current sensed through each fuse. If a programming 
failure occurs, the .avi/.txt file contains information about programming failure mode. A new 
.avi/.txt file is generated each time the programming sequence begins. If you want to save an 
.avi/.txt file, you must rename it before restarting the programming sequence. For an example 
and explanation of an .avi file, refer to the Activator User’s Guide. 

The .avi file is generated by the Activator and the .txt file is generated by the Sculptor. Silicon 
Sculptor generates the .txt file for RT and RH devices only. However, due to some limitations, 
it does not generate a .txt file for RTSX/RTSX-S devices. 

38. After loading the .afm file successfully, why am I getting "Unable to open AFMBLANK 
file" when I click on Blankcheck in Activator?  

Ans. Check if the file <family>.afm exists in the 
$ALSDIR/data/a<family>/<family>/<family>.afm directory. If the file does not exist, APSW 
gives this message. Please uninstall and reinstall the software to resolve this problem.  

39. If I program four devices in the four sockets of the activator, will I get four different .avi 
files for four parts?  

Ans. No. Actually you will get only one .avi file, but it will contain all the information pertaining 

to the four sockets.  

http://www.microsemi.com/soc/custsup/updates/index.html
http://www.microsemi.com/soc/documents/Activator_UG.pdf
http://www.microsemi.com/soc/documents/Activator_UG.pdf


 

14 FAQ’s for Microsemi Antifuse FPGA Programming 

VI.3. Sculptor  

40. Where can I get the Silicon Sculptor software?  

Ans. Silicon Sculptor for DOS and for Windows is available for download at: 
www.microsemi.com/soc/custsup/updates/silisculpt  

41. How can I measure the programming time in Silicon Sculptor DOS?  

Ans. While programming a device in Silicon Sculptor you can measure the elapsed 

time. To do this, select ALT + F10 and select ON in the Elapsed Time window prior to 

starting programming.  

42. How can I measure the programming time in Silicon Sculptor Windows?  

Ans. To measure the elapsed time during a function in Silicon Sculptor Windows, go to 

the Tools menu, choose Options, and select ON in the Elapsed Time window.  

43. Is the .avi/.txt file supported in Silicon Sculptor?  

Ans. The .txt file is supported in Silicon Sculptor only for RT and RH devices. No .txt file 

is supported for RTSX/RTSX-S devices.  

44. Why am I getting a five digit checksum (example: CSUM=7EA7C) under “Data 
Pattern” when I load an .afm file in the Silicon Sculptor Windows software?  

Ans. This checksum is not related to a Microsemi device or an Microsemi .afm file. The 

BP software performs some internal calculations, which gives the five digit checksum. 

There is no need to worry about this; it is not related to Microsemi.  

45. In the Sculptor software under Device > Option, you will see two other options 
"secure after programming" and "secure after verifying". What is the difference 
between these two options?  

Ans. Secure After Programming is the option we use for Microsemi devices. Secure 

After Verifying is something that is used for EPROM devices. BP uses the same 

interface for the Microsemi software and their own software. Selecting Secure After 

Verifying does not do anything to Microsemi devices. If you want automatic secure, use 

the Secure After Programming option. 

46. What are the functions of the Blankcheck and Checksum commands in the 
software?  

Ans. The Blankcheck command executes a test to determine if a device has already 

been programmed. Blankcheck displays a report for each socket that has an adapter 

module plugged into it. Blankcheck is performed automatically before the chip is 

programmed whenever the command is used. The result of executing Blankcheck is 

either “blank” or “not blank” followed by the silicon signature, checksum, and security 

fuse status read from the device. Only blank devices of the correct type (according to 

the design parameters) result in a blank status.  

The Checksum command verifies that the current programming file is the same that you 

used to program the device. The Checksum command compares the checksum number, 

computed from the programming file, to the checksum number programmed into the 

chip. If the two numbers are the same, the program displays “PASSED.” If the two 

numbers are not the same, the program displays “FAILED,” with additional comments to 

briefly explain why it failed. 

http://www.microsemi.com/soc/custsup/updates/silisculpt
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VII. Programming Files and Functions  

VII.1. General  

47. What files can I use to program a device?  

Ans. See Table 1:    

Table 1:   Files for Programming  

Activator  Silicon Sculptor  

.adb or .afm file  .afm file  

48. Can I still program with .def and .fus files on Activator?  

Ans. Yes. You can still program Microsemi FPGAs with the .def and .fus files by using the 
appropriate method from the Knowledge base article located at:  
www.microsemi.com/soc/documents/ProgFiles_AFM_AN.pdf  

Microsemi supports the .afm format.  

49. Can I generate the .afm files from .def and .fus files?  

Ans. Yes. It is possible to generate .afm files from .def and .fus files, but the procedure to do 

so depends on your version of the Microsemi software. Choose the procedure that 

corresponds to the software version you are running from the Knowledge base article 

located at: www.microsemi.com/soc/documents/ProgFiles_AFM_AN.pdf  

50. How are the programming files generated?  

Ans. The Designer software is used to generate the programming file. The Fuse button in 

the Designer software generates the .afm file. You can also generate the .afm file using the 

following path: File > Export > Fuse Files.  

51. Are .afm files that are generated by different versions of Designer compatible?  

Ans. All the .afm files generated from Designer v3.0 and later are forward compatible. For 

example, an .afm file generated from Designer v3.0 can be used to program a part using 

Designer v3.1.1.  

 For SX family devices: If the .afm file was generated using R1’99 Update One or 
earlier, you must regenerate a new .afm file with R1 ’99 Update Two or newer. 
For A54SX72A devices, the .afm file should be generated using Designer R1-
2001 SP4 or newer.  

 For A42MX24 and A42MX36 devices: If the .afm file was generated using R1’99 
Update One or earlier, you must regenerate the .afm file using R1’99 Update 
Two or newer.  

 For ACT1 and 40MX family devices: Microsemi has experienced some issues 
with the .afm files generated using R1’99 Release and R1’99 Update One. To 
solve these issues, you must use R1’99 Update Two or newer.  

Designs that are generated from Designer versions prior to v3.0 (that is, before the .afm file 

was introduced) are programmed using the .def and .fus files. 

  

http://www.microsemi.com/soc/documents/ProgFiles_AFM_AN.pdf
http://www.microsemi.com/soc/documents/ProgFiles_AFM_AN.pdf
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52. How do I check which version of Designer was used to create my .afm file?  

Ans. Open the .afm file in a text editor. The header states the Designer release number 

that was used. The following example is an excerpt from an .afm file:  

| PROGRAM Designer Series (tm) Development System  

| VERSION R2-2001 Post-Prod 4.3.4.7  

53. Can I use the same programming file with devices of different technologies?  

Ans. If you generate a programming file with one technology, (for example, a1020A), 

but actually program a different technology of the same device (for example, an 

RH1020), there are risks that this operation will not be successful. Because of the 

differences in separate revisions of devices, there are variations in programming. They 

include the programming voltage level and length of time allowed before the device 

"times out," that might result in a programming failure.  

In addition, there are AC timing differences from one technology to the next. If proper 

simulation is not performed, the new device technology may not exhibit the same AC 

characteristics as the original. To avoid these issues, Microsemi recommends using the 

.afm files generated specifically for the device you want to program. See the User 

Action section below for more information.  

User Action  

 Required: Whenever you change to a new device, you must update the design 
files to the targeted device type prior to programming the new device. This 
ensures that device receives the proper programming steps and settings.  

 Recommended: Microsemi recommends that you re-simulate your designs for 
the new device type to ensure that all timing requirements are met.  

 Warranty: Microsemi does not provide any warranty for devices that are 
programmed with an incorrect device type file. Programming failures resulting 
from the device being programmed with the incorrect file types will not be 
accepted for replacement unless approved by Microsemi Technical Support.  

54. Can I retarget to a compatible device with just an .afm file?  

Ans. No. The .afm file for one technology cannot be used to program a device of 

another technology-even if the parts are compatible. In general, there is no way to 

regenerate any design database information from just the .afm file.  

55. Can I use ACT 2 .afm files to program 1200XL devices?  

Ans. While it is true that ACT 2 and 1200XL devices are pin-to-pin compatible, their .afm 

files are not the same. The primary difference between ACT 2 devices and 1200XL 

devices is the length of the register used for programming; 1200XL devices have a 

much longer register chain. To program a 1200XL device, you must regenerate the .afm 

file. Microsemi also recommends that you rerun timing and simulation since the 1200XL 

devices are faster.  

Note: You may use ACT 2 .afm files to program “A” rev ACT 2 devices (1280 .afm file 

can program 1280A device) since the register chains are of the same length. 

56. Can I use 1020A files to program a 1020B device?  

Ans. Yes, the 1020B is compatible to the 1020A, but the timing will be different because 

the 1020B device technology is faster. Microsemi strongly recommends that you rerun 

all timing analyses after making the compatible die change.  
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57. How do I make a device or package change?  

Ans. Whenever you make a device or package change to an existing device, other 

components of the design database need to be regenerated. Exactly what needs to be 

regenerated depends on what type of change you make.  

58. What is the silicon signature?  

Ans. A silicon signature is a 1-5 digit hexadecimal number that can optionally be 

programmed into a Microsemi device. You can assign the digital signature during the Fuse 

Generation function in Designer. This feature is provided so you can program an individual 

identification code into your devices. After programming, the silicon signature can be read 

from the device by executing Blankcheck within the Window's programming software or by 

executing Device > Actel_Chksum in the SCULPT software.  

59. What is PINCHECKSUM in the .afm file?  

Ans. The PINCHECKSUM variable in the .afm file is the package-pin checksum. This 

checksum always has two values, as shown in the following line:  

; VAR PINCHECKSUM 5e7dbf37_c9cf9fee  

The first value (5e7dbf37) represents the package type used (for example, 84PLCC vs. 

84CQFP). The second value refers to the mapping between design I/Os and their pin 

assignments.  

60. How do I verify that a device has been programmed?  

Ans. You can verify that a Microsemi FPGA has been programmed by placing it in any 
supported programmer and running a blank check/Actel checksum.  

61. How do I determine the status of the Microsemi security fuse?  

Ans. How you verify the status of the security fuses in a Microsemi device depends on the 

type of programmer you have.  

62. What is the fuse checksum?  

Ans. The fuse checksum is a four digit hexadecimal number programmed into all Microsemi 

devices at the end of the programming sequence. This information can be used to match a 

programmed device to its programming (.afm) file. The fuse checksum is calculated from the 

fuses in the .afm file and stored in the device. This number is unique for each fuse map. This 

number can also change when the target die is changed, even if no change is made to the 

layout of the device. The checksum is the last information programmed to the device, which 

is the best way to ensure that all the information has been programmed successfully. 
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63. What causes the FUSCHECKSUM to change?  

Ans. To uniquely identify a given design, Microsemi created a FUSCHECKSUM in the 

.afm file. Any design modification that causes a change in the fuse map (that is, the list of 

fuses to be programmed) will cause a related change in the FUSCHECKSUM. However, 

there are situations when the FUSCHECKSUM changes, even though no modifications 

were made to the design (see Situation One and Two below). These changes apply to all 

devices.  

Situation One  

There were detailed router changes between the R2-1998 and R1-1999 versions of 

Microsemi Designer software, which could result in different FUSCHECKSUMs from the 

same, unchanged .adb file. In this case, it is important to remember that the timing is the 

same since only the software version changed and not the design's placement and 

routing.  

Situation Two  

Between R1-1999 and R2-1999, the entire unused freeway tie-offs were interchanged 

between VCC and GND. As a result, there are guaranteed differences in the 

FUSCHECKSUMs for .afm files that are based on the same .adb file, but generated by 

the two different software versions. In this case, it is important to remember that the 

timing is the same since only the software version changed and not the design's 

placement and routing.  

Note: FUSCHECKSUM will be same for conversions between R2-1998 and R3-1998 and 

for conversions between R2-1999 and R1-2000.  

64. What is the difference between Array, Security, Probe, and Program fuse types?  

Ans. When you program a Microsemi FPGA with either the APSW software and an 

Activator or SCULPT software and a Silicon Sculptor, you have the option to select the 

fuse type. Depending on the device family you are using, you will be given the options as 

shown below:  

Table 2:   Fuse Types  

Fuse types for all Microsemi antifuse 
devices except ACT 1 and 40MX  

Fuse types for ACT 1 and 40MX 
devices 

Array  

Security  

Array 

Probe 

Program 

The differences between these fuse types are as follows:  

 Array Fuse: Used to implement your design on the FPGA  

 Security Fuse: Used to disable Action Probe, Silicon Explorer, and ALS 
Debugger capabilities  

 Probe Fuse: Used to disable Action Probe, Silicon Explorer, and ALS Debugger 
capabilities (ACT 1 and 40MX only)  

 Program Fuse: Used to prevent additional data from being programmed into 
the device (ACT 1 and 40MX only)  

 For more information, refer to the Activator User’s Guide. 

http://www.microsemi.com/soc/documents/Activator_UG.pdf
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65. Will parts programmed with the Silicon Sculptor have the same Checksum as devices 
programmed on the Activator?  

Ans. Yes.  

66. What is the probability of getting a correct checksum but an incorrect program fuse?  

Ans. Each fuse is individually verified during programming and additional programming 

verification tests are performed before the checksum is programmed, as described above. 

Programming occurs in this order to ensure that the array fuses are programmed correctly. 

All units that pass programming are guaranteed to function properly.  

67. How can antifuse resistance be determined? Is it possible that fuse resistance could 
be great enough to cause a delay greater than the worst case simulated delay?  

Ans. Antifuse resistance cannot be directly determined on a programmed unit. However, 

worst-case timing is guaranteed for programmed parts. During programming, the current 

sensed through each fuse is recorded in the .avi/.txt file each time you program a RH/RT 

device (prior to RTSX-S).  

68. Concerning the programming file .afm, is there a way of incrementing the silicon 
signature without re-doing the place-and-route?  

Ans. There is no way of incrementing the silicon signature without regenerating the .afm file. 

However, it is not necessary to run place-and-route repeatedly.  

69. Can I modify the header line from "VAR SIG xxxxx" to "VAR SIG yyyyy" in the .afm file 
to change the silicon signature?  

 Is the file going to be corrupted?  

 Is the checksum going to change?  

 Are there any other side effects?  

Ans. The entry in the .afm "VAR SIG xxxx" is simply a comment in the file. Modifying this 

entry does not affect what gets programmed into the FPGA. The programmer uses this value 

to compare what is programmed in the part. Changing this value will result in an error when 

reading the silicon signature back since the programmer is comparing the value in the "VAR 

SIG xxxx" and what is programmed in the part, which is not altered when you modify "VAR 

SIG xxxx". To change the silicon signature, you need to change the silicon signature fuses 

that get programmed in the .afm. The only way to do this, with the .afm, is to regenerate it 

from Designer. In any case, you will need a separate .afm for each unique silicon signature.  
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70. Why does the size of the .adb file change during programming?  

Ans. To program a Microsemi device using Microsemi Windows programming software 

(from Designer v3.0 or later), you can use either the .adb or the .afm file. The file that is 

actually used during programming is the .afm file, which you can create manually by 

clicking Fuse in the Designer flow chart. However, if you skip this step, you can open the 

.adb file directly and the programming software internally creates the .afm file and add it 

to the .adb database file. This means that the first time you use this database to program 

a device; the .adb file size and timestamp change. If you reuse the same database for 

subsequent programming, the .adb file does not change size.  

Keep in mind that when you program with the .adb file, the auto-generated .afm file is 

NOT exported to your project directory as a separate file. The only way to export the .afm 

file (which you need to do if you are programming with Silicon Sculptor) is to click Fuse in 

the Designer flow chart.  

71. What is the Microsemi recommended RT/RH programming flow?  

Ans. The Microsemi recommended programming flow for a RT/RH device is as follows:  

1. Test the Activator/Silicon Sculptor.  

2. Program a commercially equivalent part.  

3. Program an RT/RH device.  

4. Save the .avi/.txt files (where required).  

72. Can I use a .dio file to program with Silicon Sculptor?  

Ans. Yes. You can use a Data I/O (.dio) file format to program some Microsemi devices 

with Silicon Sculptor. To do so, simply load the .dio file using the Load > Buffer 

command and program as usual. Microsemi recommends you use the .afm file format to 

program the devices, since Microsemi does not have control over the Data I/O 

programming algorithm and does not test it.  

73. Are all the antifuses checked by Activator?  

Ans. Every fuse being programmed is checked during the programming sequence. 

Programming pulses are applied across each fuse individually until current is sensed 

through the fuse. Once current is sensed, additional "soak" pulses are applied to ensure 

the fuse is programmed. After soak pulses are applied, the programming voltage is 

lowered and the current is sensed through the fuse again. This verifies that the sensed 

current is through the programmed fuse and not caused by leakage in the device (check 

six test).  

Each fuse is checked individually as the array is programmed. After all array fuses are 

programmed, a series of additional "net shorts" tests are performed to verify that no 

additional fuses have been programmed. Checksum fuses are programmed after the net 

shorts tests are performed. 
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VIII. Device  

VIII.1. RH/ RT/ Military Devices  

74. Is there a need for dynamic or static burn-in after programming?  

Ans. There is no need for additional burn-in after the units have been programmed. Static 

and dynamic burn-in are included in the manufacturing flow for all RH/RT devices.  

75. Can 172 CQFP sockets withstand military temperatures (-55°C to +125°C)?  

Ans. The 172-CQFP socket used by Microsemi for military temperature testing is a custom 

socket made by Yamaichi (part number IC51-196-1952). The socket operates in the military 

temperature range (-55°C to +125°C).  

76. Are there statistics for parts failing after burn-in?  

Ans. Since units are tested at the fabs, Microsemi does not have detailed information on 

units that fail electrical tests after burn-in. However, we do receive the test summaries and 

travelers, so we know the number of failures is very small (the test flow includes PDA 

calculations that must be met in order for the lot to ship). As for test failure modes after burn-

in, that data belongs to the fabs.  

77. What is Expected Programming Failure for RH/RP/RT devices?  

Ans. Refer to Table 3:    

Table 3:   Maximum Allowed Programming Failures for RH/RP/RT devices  

Sample Size  Max Number of Failures  

10  3 

20  4 

50  6 

100  10 

Note: Programming yield should normally be over 95%. These sample sizes allow a larger 

percentage due to statistical fluctuations attributable to the small quantities. If you begin to 

see high programming failures, stop programming and contact your local Microsemi 

representative or the Technical Support hotline at 1-800-262-1060.  

78. Does Microsemi recommend programming a commercial part before programming an 
RH/RT part?  

Ans. Before programming a RadHard or RadTolerant device, Microsemi recommends that 

you program a commercially equivalent device to ensure the proper setup of the hardware 

and software. After you have successfully programmed a commercial device, you can 

program your RadHard or RadTolerant device. 
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VIII.2. Commercial/Industrial  

79. What is the expected programming failure rate for Industrial/Commercial devices?  

Ans. Refer to programming failure allowance tables in 

www.microsemi.com/soc/documents/FA_Policies_Guidelines_5-06-00002.pdf  

80. What is the expected failure rate for –F devices?  

Ans. Refer to programming failure allowance tables in 

www.microsemi.com/soc/documents/FA_Policies_Guidelines_5-06-00002.pdf 

VIII.3. General  

81. Where can I find the lot number and date code on Microsemi FPGAs?  

Ans. To trace a device's lot history from qualification test records, Microsemi must have 

the lot number of the device under investigation. The lot number allows Microsemi to 

identify the silicon ingot and wafer from which the device was fabricated. For most 

Microsemi FPGAs, the lot number is printed on the bottom of the package and the date 

code is on the top, although there are exceptions. In either case, the lot number is easy 

to identify given the following example:  

Lot Number: 2ACT312381  

Date Code: 9919  

The date code indicates that the device is fabricated in the 19th week of 1999, and the 

wafer is from lot number 2ACT312381 

82. Are electrical characteristics of the device guaranteed after programming? Is it 
necessary to perform functional tests on the programmed units?  

Ans. The electrical characteristics outlined in the Microsemi device datasheet are 

guaranteed for all devices that pass programming. Additionally, correct functional 

behavior is guaranteed for all devices that pass programming.  

83. Can I program the antifuse devices on board?  

Ans. No. Microsemi does not recommend this and does not support it. 

 

http://www.microsemi.com/soc/documents/FA_Policies_Guidelines_5-06-00002.pdf
http://www.microsemi.com/soc/documents/FA_Policies_Guidelines_5-06-00002.pdf
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